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1 Overview

1 Overview

The GP-NIP demo board can be used to test all functions of the GC-NIP nonius interpolation circuit.

The GP-NIP is designed for a hardware-oriented function test of the IC. The board possesses various
measuring points that allow to check all important signals. Thus, adaptation to the most varied encoder sys-
tems is possible.

The configuration of the IC and reading-out of the measured values are performed either via the USB, SPI
or SSI/BiSS interface. To this end, in addition to connection to an external micro-controller or FPGA system,
it is also possible to use the supplied “GC NIP Monitor” software. Furthermore, ABZ square-wave signals for
external counters can be output via the RS422 interface.

The demo board can be supplied with operating voltage either via USB, a power pack (connectors or screw
terminals) or the appropriate interface.

The desired interface (USB, SPI, SSI/BiSS) can be selected by way of the appropriate jumper.

The supply voltage for the connected sensor (3.3 V or 5 V) can also be set by way of jumpers.

analog digital
T
//’ i = R 4 Y = ™
osc
40 MH2 RST »  ABZ (RS422)
SENSOR o
3v3/ 5V
( N ™
\ —» GC-L§ - ssl / BISS
A 4 . J
. " - N
AT
—» GC-LS > =
% \ ’/ ’
SENSOR N - . "
3v3/ 5V
( T SPI
SWITCHES / BUTTONS |
// \\ J

- J

Fig. 1: Block diagram
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2 Properties

2 Properties

Analog input Sinusoidal / cosinusoidal / reference (index) signals,; differential or single-ended
Adjustable amplification for 660 mVy,/ 250 MV, / 120 mVy,/ 60 mVy,

Maximum input frequency 150 kHz for nonius calculation

Maximum input frequency 90 kHz for interpolation

ABZ 90° square-wave sequences (A/B/Z) for both channels
Adjustable width of zero signal Z to % or 1 period A/B
Error signal

Interrupt signal for external processing

Service signals for sensor adjustment

SPI 30-bit counter value for the interpolation channels
Up to 22-bit value for the absolute position
9-bit sensor status information on each channel

Compatible with standard-SPI: 16-bit, MSB first, up to 15 MHz

SSI| and BiSS Up to 30-bit counter value
2-bit sensor status

Gray code / binary code
Adjustable timing

SSI ring operation

Additional inputs

Trigger input for storage of the measured value
= Preset signal for adjustment and storage of the counter value
m Reference position alignment using external signal

Configuration options = Integrated EEPROM
m Configuration inputs
m Serial interface (SPI/BiSS)

Interpolation rate = 256 to 8192, divisible by 8
= Adjustable divider 1/2/4/8 for the A/B-signals and counter values on each channel

Nonius graduation =  Number of periods per turn for absolute position calculation
= [nterpolation rate / [8 /16 / 32 / 64]

Nonius correction = Correction coefficients stored in the EEPROM
m Software based calibration process for determination of the correction coefficients

Signal correction = Patented digital controller for the offset, control range +10% of the nominal amplitude
= Patented digital controller for the amplitude, control range factor 60% ... 120% of the nominal
amplitude
= Digital potentiometer with 64 stages for phase correction; selectable range +5° or £10°
= [nput signal monitoring with configurable error indication

Fault suppression = Adjustable low-pass filter 10 kHz, 75 kHz, 150 kHz
= Digital hysteresis for suppression of the edge noise at the output (configurable 0...7)
® Selectable minimum edge distance at the output (bandwidth limitation)

Reference signal ® Adjustable reference mark position in 32 steps, 0 ... 360°
processing = Optional: high precision alignment of the reference mark position (configuration via external
signals possible)
= Determination of the optimum reference position by way of SPI/BISS or auxiliary signals
® Processing of distance coded reference marks
® Measured-value trigger at the reference-mark position

Further information = Optional Master-SPI interface for output and manipulation of SSI/BiSS-Data
B 2-stage measured value trigger
® Constant delay between sampling and measured value for all resolutions: Count value (both
channels): 4.4us, Absolute nonius position: 8us

Important characteristics: Demo board

Operating voltage 3.3VDC/5VDC
I/O voltage, digital 3.3VDCor5VDC
Temperature range 0...70°C

Dimensions of the GP-NIP  PCB 100 mm x 130 mm
Interface frequency SPI: 15 MHz, BiSS: 10 MHz, SSI: 5 MHz

Table 1: Properties
For further information on the GC-NIP IC, refer to the Data Sheet which is available for download from our
website www.gemac-chemnitz.de/en/products/interpolation.
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3 Hardware

3 Hardware
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Fig. 2: GP-NIP demo board
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3 Hardware

3.1 Connections

Attention: When configuring the hardware of the demo board, first make sure that it is disconnected from
the power supply!

3.1.1 SUB-D X1 pin connector assignment (ABZ — RS422, channel 1)

T T S

1 AP Square-wave signal A positive

2 GND GND

3 BP Square-wave signal B positive

4 5V /3,3VDC 5V /3.3 VDC power supply

5 EP Error signal NERR positive

6 PRESET Preset signal — for the zero position independent of reference
marks

7 ZN Square-wave signal Z negative

8 TRIG Trigger signal — acceptance of count value to trigger hold register

9 AN Square-wave signal A negative

10 GND GND

11 BN Square-wave signal B negative

12 5V /3,3VDC 5V /3.3 VDC power supply

13

14 ZP Square-wave signal Z positive

15 EN Error signal NERR negative

Table 2: SUB-D X1 pin connector assignment (ABZ — RS422, channel 1)

3.1.2 X2 push-on terminal strip pin assignment (SPI)

T N T

1 5V 5V /3.3 VDC power supply

2 SCK SPI Clock

3 MISO SPI MISO

4 MOSI SPI MOSI

5 SEN_SPI SPI Enable

6 PRESET Pin PRESET for the GC-NIP

7 TXENA/TRG Pin TXENA / TRIGGER of the GC-NIP
8 GND GND

Table 3: X2 push-on terminal strip pin assignment (SPI)
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3.1.3 X3 push-on terminal strip pin assignment (BiSS / SSI)

T T S

© 00 N o g A~ W N P

e =
w N P O

14

5V
5V

MA_P

MA_N

SLO_P

SLO_N

SLI_P

SLIN
SEN_SSI/BiSS_P
SEN_SSI/BiSS_N
PRESET
TXENA/ TRG
GND

GND

5V /3.3 VDC power supply
5V /3.3 VDC power supply
SSI / BiSS MA positive
SSI/ BiSS MA negative
SSI/ BiSS SLO positive
SSI/ BiSS SLO negative
SSI/ BiSS SLI positive
SSI/ BiSS SLI negative
SSI / BiSS enable positive
SSI / BiSS enable negative
Pin PRESET des GC-NIP
Pin TXENA / TRG des GC-NIP
GND

GND

Table 4: X3 push-on terminal strip assignment (BiSS / SSI)

3.1.4 X4 push-on terminal strip pin assignment (GND)

T T S

1-6

GND

AGND GC-NIP (analog ground)

Table 5: X4 push-on terminal strip pin assignment (GND)

3.1.5 X5 push-on terminal strip pin assignment (test points for ABZ, channel 1)

T T S

1
2

A
B

Z
NERR
GND

Square-wave signal output A, channell, directly on the GC-NIP

Square-wave signal output B, channell, directly on the
GC-NIP

Square-wave signal output Z, channel 1, directly on the GC-NIP
Square-wave signal output NERR, directly on the GC-NIP
DGND GC-NIP (digital ground)

Table 6: X5 push-on terminal strip pin assignment (test points for ABZ, channel 1)
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3 Hardware

3.1.6 SUB-D X6 pin connector assignment (sensor 2)

T T S

1 SINP Sensor sinusoidal signal input, positive, channel 2

2 GND AGND GC-NIP (analog ground)

3 COSP Sensor cosine signal input, positive, channel 2

4 SVCC2 5V /3.3 VDC power supply

5 - -

6 = -

7 REFN Sensor reference-point signal input, negative, channel 2
8 = -

9 SINN Sensor sinusoidal signal input, negative, channel 2

10 GND AGND GC-NIP (analog ground)

11 COSN Sensor cosine signal input, negative, channel 2

12 SVCC2 5V /3.3 VDC power supply

13 VOCH2 Center voltage output 1.1 V (for 3.3 V sensors only!), channel 2
14 REFP Reference-point signal input, positive, channel 2

15 - -

Table 7: SUB-D X6 pin connector assignment (sensor 2)

3.1.7 X7 jumper (NRES)

T T T

L i Open — reset inactive
2 GND Closed — reset active

Table 8: X7 jumper (NRES)

3.1.8 X8 jumper pin assignment (selection of the supply voltage for the sensor at channel 1)

T T S

1 5V 5 VDC supply voltage
2 SVCC1 Pin for the selected voltage — e.g. 1 - 2 = 5V sensor power supply
3 3V3 3.3 VDC supply voltage

Table 9: X8 jumper pin assignment (Selection of the supply voltage for the sensor at channel 1)
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3 Hardware

3.1.9 X9 monitor signals, channel 1

1 AGND Analog ground

2 CMON1 Test point for cosine monitor signal from channel 1 of GC-NIP

3 AGND Analog ground

4 SMON1 Test point for sinusoidal monitor signal from channel 1 of GC-NIP
5 AGND Analog ground

6 VOCH1 Test point for center voltage from channel 1 of GC-NIP

Table 10: X9 monitor signals, channel 1

3.1.10 X210 monitor signals, channel 2

1 AGND Analog ground

2 VOCH2 Test point for center voltage from channel 2 of GC-NIP

3 AGND Analog ground

4 SMON2 Test point for sinusoidal monitor signal from channel 2 of GC-NIP
5 AGND Analog ground

6 CMON2 Test point for cosine monitor signal from channel 2 of GC-NIP

Table 11: X10 monitor signals, channel 2

3.1.11 X12 connector pin assignment (test points for the input signals at channel 1)

I T T

1 AGND Analog ground

2 SVCC1 Selected sensor supply voltage

3 REFN Reference-point signal input, negative, channel 1
4 REFP Reference-point signal input, positive, channel 1
5 COSN Cosine signal input, negative, channel 1

6 COSP Reference-point signal input, positive, channel 1
7 SINN Reference-point signal input, negative, channel 1
8 SINP Reference-point signal input, positive, channel 1

Table 12: X12 connector pin assignment (test points for the input signals at channel 1)
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3 Hardware

3.1.12 X13, X14, X15 connections (power, USB)

X13 Input 1 — GND GND

Input 2 - + 5 VDC Operating voltage 5V / 3.3 VDC
X14 USB Mini USB
X15 Socket for DC connector 5.0 x 2.1 mm Operating voltage 5V / 3.3 VDC

Table 13: X13, X14, X15 connections (power, USB)

3.1.13 SUB-D X16 connector pin assignment (sensor 1)

T T S

1 SINP Sensor sinusoidal signal input, positive, channel 1

2 GND AGND GC-NIP (analog ground)

3 COSP Sensor cosine signal, positive, channel 1

4 SVCC1 5V /3.3 VDC power supply

5 = -

6 - -

7 REFN Sensor reference point signal input, negative, channel 1
8 = -

9 SINN Sensor sinusoidal signal input, negative, channel 1

10 GND AGND GC-NIP (analog ground)

11 COSN Sensor cosine signal input, negative, channel 1

12 SVCC1 5V /3.3 VDC power supply

13 VOCH1 Center voltage output 1.1 V (for 3.3 V sensors only!), channell
14 REFP Reference-point signal input, positive, channel 1

15 - -

Table 14: SUB-D X16 connector pin assignment (sensor 1)

3.1.14 X17 jumper pin assignment (selection of the supply voltage for the sensor at channel 2)

T T T

1 5V 5 VDC supply voltage
2 SVCC2 Pin for the selected voltage — e.g. 1 - 2 = 5V sensor supply
3 3v3 3.3 VDC supply voltage

Table 15: X17 jumper pin assignment (selection of the supply voltage for the sensor at channel 2)
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3.1.15 X18 push-on terminal strip pin assignment (test points for the input signals at channel 2)

I T [

1
2
3
4
5
6
7
8

AGND
SVCC2
REFN
REFP
COSN
COSP
SINN
SINP

Analog ground

Selected sensor supply voltage

Reference-point signal input, negative, channel 2
Reference-point signal input, positive, channel 2
Cosine signal input, negative, channel 2
Reference-point signal input, positive, channel 2
Reference-point signal input, negative, channel 2

Reference-point signal input, positive, channel 2

Table 16: X18 push-on terminal strip pin assighment (test points for the input signals at channel 2)

3.1.16 SUB-D X19 connector pin assignment (ABZ — RS422, channel 2)

T T [

o a b~ W N B

~

9
10
11
12
13
14
15

AP

GND

BP

5V /3.3VDC
EP

PRESET

ZN
TRIG

AN

GND

BN

5V /3,3VDC

ZP
EN

Square-wave signal A positive
GND

Square-wave signal B positive
5V /3.3 VDC power supply
Error signal NERR positive

Preset signal — for the zero position independent of reference
marks

Square-wave signal Z negative

Trigger signal — acceptance of the count value to the trigger hold
register

Square-wave signal A negative
GND
Square-wave signal B negative

5V /3.3 VDC power supply

Square-wave signal Z positive

Error signal NERR negative

Table 17: SUB-D X19 connector pin assignment (ABZ — RS422, channel 2)
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3.1.17 X20 push-on terminal strip pin assignment (test points for ABZ, channel 2 / micro-controller

interface)

I T
1 TXENA/ TRG Pin TXENA / TRG des GC-NIP
2 MCMISO MISO puC interface
3 STSAMP / A2 Square-wave signal output A, channel 2 / STSAMP, uC interface
4 MCMOSI / B2 Square-wave signal output B, channel 2 / MOSI, uC interface
5 MCSCK / 22 Square-wave signal output Z, channel 2 / SCK, uC interface
6 NERR Square-wave signal output NERR, directly on the GC-NIP
7 GND DGND GC-NIP (digital ground)

Table 18: X20 push-in terminal strip pin assignment (test points for ABZ, channel 2 / micro-controller
interface)

3.1.18 J1-J5jumpers

J1i Pin 1 — BiSS / SSI (ENABLE) Open — BiSS / SSI deactivated
Pin 2 — GND Closed — BiSS / SSI active (LD1 active)
J2 Pin 1 — USB (ENABLE) Open — USB deactivated
Pin 2 — GND Closed — USB active (LD2 active)
J3 Pin 1 — GND Open — SPI deactivated
Pin 2 — SPI (ENABLE) Closed — SPI active (LD3 active)
J4 Pin1 -5V Open — for the 5V sensors at channel 2 (gain 0.66)
Pin 2 — LSB Closed — for the 3.3V sensors at channel 2 (gain 1)
J5 Pin1 -5V Open — for the 5V sensors at channel1 (gain 0.66)
Pin 2 — LSB Closed — for 3.3V sensors at channel 1 (gain 1)

Table 19: J1 — J5 jumpers

3.2 Switches and buttons

S1 Reset button — demo board reset Initialization of GC-NIP and selected interface

S2 Switch 1 — CFGGAIN(0) / HWA(0) Configuration of nominal amplitude / hardware address
Switch 2 — CFGGAIN(1) / HWA(1) Konfiguration Nominal amplitude / hardware address

S3 Switch 1 — CFGAF(0) / HWA(2) Configuration of analog filter / hardware address
Switch 2 — CFGAF(1) / HWA(3) Configuration of analog filter / hardware address

S4 Switch 1 — CFGDIR / TM2 Configuration of counting direction for nonius / test mode
Switch 2 — -

S5 TRG button Acceptance of count value to trigger hold register

S6 PRESET button Setting of zero position independent of reference marks

Table 20: Switches and buttons
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3.3 LEDs
LD1 LED OFF — BiSS / SSl inactive
LED ON (yellow) — BiSS / SSI active
LD2 LED OFF — USB inactive
LED ON (yellow) — USB active
LD3 LED OFF — SPI inactive
LED ON (yellow) — SPI active
LD4 LED OFF — no error signal at NERROR
LED ON (rot) — error signal at NERROR — error occurred
LD5 LED OFF — no operating voltage present

LED ON (green) — operating voltage present

Table 21: LEDs
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4 Demo Board Specifications

4 Demo Board Specifications
paameer fun[pp e Jume |
5,0 55 VDC

Supply voltage 4,75 ; 5

Power supply, internal 3,3/5,0 VDCS
I/O voltages 3,3/5,0 \%
Current consumption tbd mA
Operating temperature 0 70 °C
External clock 25 MHz
Center voltage VO 1,08 1,1 1,12 \%
Output current VO 1 mA

Table 22: Specifications

For the specifications of the GC-NIP IC, refer to the Data Sheet which can be downloaded from our website
www.gemac-chemnitz.de/en/products/interpolation.
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5 GC-NIP Monitor Software

5 GC-NIP Monitor Software

5.1 Overview

The parameters and specifications of the GC-NIP are controlled and visualized by way of the GC-NIP Monit-
or Software. It is designed for Windows operating systems and communicates with the IC directly via USB
(USB-to-SPI conversion on the board) or the GEMAC USB/SPI converter. Optionally, the configuration is
also possible by way of the software via the BiSS interface with an appropriate BiSS user interface (e.qg.
iCHaus MB4U).

5.2 System requirements

To ensure proper program execution, your PC or notebook should meet at least the following system re-
guirements and possess one of the following operating systems:

Hardware:
Processor: 2GHz or higher (recommended: multi-core system)
Min. 512 MB RAM
Min. 1 GB free harddisk memory (for the measuring data)
24-bit VGA card (recommended: 32-bit)
Display resolution: 1,024x768 pixels or higher
Free USB interface
Supported operating systems:
Microsoft Windows® 2000
Microsoft Windows® XP
Microsoft Windows® Server 2003
Microsoft Windows® Vista
Microsoft Windows® 7

5.3 Installation

The software and required USB drivers for the interfaces are installed by way of the executable file (in-
staller) 44800-SW-x-x-GC-NIP Setup.exe.

5.4 Program structure

The graphical user interface of the application is divided into a dialog bar, a status bar and up to three areas
for display of the measured values. The dialog bar is located directly beneath the toolbar. In this area, the in-
terface — SPI or BiSS - is selected. Furthermore, a measurement can be started here and the time for the
interrogation interval can be selected; it is also possible to trigger commands (reset counters). The available
GC-NIP measurement values and status information are represented in the three measurement windows.
To this end, a measurement must be started via the dialog bar. The measured values are refreshed at the
set interrogation interval.

After starting the application, as shown in Fig. 3, the software checks that the hardware is present. Once the
hardware is detected according to the selected interface, its identifier is displayed in the status bar. If a cir-
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5 GC-NIP Monitor Software

cuit is connected correctly and activated, in addition the designation of the integrated circuit (e.g. “IC: GC-
NIP”) is displayed in the status bar. If no integrated circuit was detected, “Unknown” is displayed.

r R
Al Untitled - GC-NIP Monitor (=] = [z
File View Communication Extras Debug Help
- | j S |
Sl ? . AGEMAC
Interface Commands Measurement
® SPI BISS Init ResCnt ResCtrl Sample count: 1 V| Loop Interval: 40 ms 3 Start
IP Measurement Channel 1 X IP Measurement Channel 2 X Nonius Measurement X
Display: Angle Count value Display: Angle Count value Trigger Nonius
TRG ENON
Gain cosine: . Gain cosine: (= ] TRGZ
Offset cosine: | N NN Offset cosine: | N TRGOVL
Gain sine: s — s w— Gain sine: [ — — —
Offset sine: T . Offset sine: [ mem e
Vector: [ = m— v — ] Vector: [ m— — — |
ADCcosine: | ADCcosine:
ADC sine: [ s s | ADC sine: |5 s s |
EFAST EFAST
EABZ EABZ
_’\ Meas. Values - View / "\ Meas. Values - View / ' Meas. Values - View )
|Ready USB: GEMAC - TB GC-NIP IC: GC-NIP @ NUM
A

Fig. 3: GC-NIP Monitor main window

If the BISS interface is used, it is imperative that the connections between integrated circuit and interface, as
well as between interface and PC are present to enable the software to find the hardware during the hard-
ware scan for new devices. In some cases, the interface selection must be changed after connecting the
hardware once more to restart the hardware scan.

5.5 Menu bar
| New document Creates an empty document.
- . -
'~ Open document Reads the program settings from an existing document.
H Save document Saves the program settings in a document.
. Oscilloscope view Opens the oscilloscope view; see Chapter 5.9.
;}; Export data Exports the measured data to a file.
1
Iﬁ Configuration Opens the configuration window; see Chapter 5.8.
7 About Displays information about the program and the connected hardware.
L]
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5.6 Help functions

When the configuration program was developed, special attention was devoted to a clear and self-explain-
ing graphical user interface. Many elements of the user interface show detailed explanations when you posi-
tion the mouse pointer on them (tooltip or status text).

The settings made in the program can be saved in a setup document with the extension “.gcnip” and re-
stored when necessary.

5.7 Measurement

Once a GC-NIP IC was connected to the PC and detected by the software, you can start a live measure-
ment by clicking on the “Start” button. The displays in the three measurement windows are refreshed at the
set intervals. The specification for the measurement interval is a direction specification. The actual meas-
urement interval is dependent on the software configuration, interface and PC capability and capacity utiliza-
tion.

5.7.1 Measuring the interpolation in channel 1 and channel 2

IP Measurement Channel 1 X

Ink

\
i

Measured-value

display Display: Angle Countvalue | |
Displayed
Gain cosine: s o s — | value selection
Offset cosine: I NI
Gain sine: B
_ | | offset sine: [ —— — |

_Quallty_ of the Neckors s o — s —L

input signals e — Error status
ADC sine: s —— — | (LEDs)

il
=
4

EABZ

Meas. Values - View

Fig. 4: Measuring the interpolation in channel 1 and channel 2

The two interpolation channels with status and error information for the input signals are displayed in the
windows separately. During a measurement, either the interpolated count value or the current phase angle
can be displayed for the individual channels.

The parameters of the sensor signals and the controller are represented by way of LED bars (see Table 23
and Table 24). Errors are displayed by way of LED visualization.

Table 23: Sensor monitoring

Cosine gain LED bar Controller correction value for the signal amplitude
Sinusoidal gain

LED The gain controller for the input signal has reached its limit.
Cosine offset LED bar Controller offset correction value
Sinusoidal offset . . o

LED The input signal offset controller has reached its limit.
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Vector LED bar Amount of vector for the input signals
LED The signal vector formed from cosine and sinusoidal signals is too small.
ADC cosine LED bar Range of values of the AD converter
ADC sinusoidal . . . . . .
LED The AD converter for the sinusoidal / cosine signals is overdriven.
EFAST LED The maximum frequency of the input signals is exceeded. The maximum input fre-
quency depends on the operating mode and the configuration.
EABZ LED The A, B and Z signals are faulty due to the excessive input frequency. The maxim-
um frequency is dependent on the set minimum edge spacing and the set interpola-
tion rate.

The displays of the error LEDs are dependent on the configuration of the integrated circuit. The errors can
be activated or deactivated separately or permanently saved in the CFGL configuration register. The behavi-
or of the LEDs is adapted accordingly. Further information about sensor monitoring and configuration of the
integrated circuit can be found in the GC-NIP Data Sheet.

Table 24: Range of values for sensor monitoring

LEDs Value...

Green ... lies in permissible range

Yellow, left ... Is too small; sensor signal should be adjusted.
Yellow, right ... Is too large; sensor signal should be adjusted.
Red, left ... Is too small; measurement results faulty.

Red, right ... Is too large; measurement results faulty.

5.7.2 Nonius measurement

Nonius Measurement o
. 100000
e ' o [ (e ([ e

Measured-value
display Trigger Nonius
Absolute position TRG ¢ ENON B

1 mwez ¢ = memg

- Error status
TRGOVL

Trigger status nonius calculation

" Meas. Values - View

Fig. 5: Nonius measurement

The “Nonius measurement” window displays the corrected absolute position calculated from both tracks
(POSI T register). In addition, status LEDs are displayed for trigger events and for the overflow error of the
trigger hold register, as well as in case of errors in the nonius calculation. For the functions of the status and
error LEDs, refer to Table 25.
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Table 25: Status LEDs for the nonius measurement

TRG Trigger status (pin)
Active: The next measured value read by the MVAL register was triggered by the TRG pin.
Inactive: The MVAL register comprises the current position value (POSIT register).

TRGZ Trigger status (reference signal)
Active: The next measured value read by the MVAL register was triggered by the reference material.
Inactive: The MVAL register comprises the current position value (POSIT register).

TRGOVL Trigger overflow
Active: Overflow of the trigger hold register; a trigger event was lost.
Inactive: No overflow of the trigger hold register; max. two trigger events are stored.

ENON Nonius error
Active: Implausible jump of the detected nonius value caused by faulty input signals or correction values. The
nonius sensor should be re-calibrated.

5.8 Configuration

Once the IC was detected successfully, the software attempts to read out the current configuration. The
user can either confirm or create a new configuration (Data -> New; “White page” icon). Furthermore, it is
also possible to load a previously saved configuration with the extension *.gcnip (File -> Open; “Folder”
icon).

w A
Read configuration l I

= . Do you want to read the parameters of the
connected GC-NIP?

[] Do not ask this question again.

Fig. 6: Reading out the configuration

The configuration window can be opened using the menu (Options -> Configuration) or by way of the tool-
bar. Then, various tabs for basic and extended IC configurations and for the software settings are available.

The configuration is stored with saving in the internal EEPROM of the IC and validated automatically. Thus,
the configuration used is loaded from the EEPROM either during power-on of the IC or after reset. The
validity of the configuration is stored at EEPROM address 0x00. If you wish to use the manufacturer's con-
figuration or configuring by way of pins for operation of the IC, first the EEPROM content must be validated.
To this end, an appropriate button is provided in the configuration window (“Sensor — Expert”). Furthermore,
the EEPROM validity is displayed.

Further information about the manufacturer's and user's configurations can be found in the GC-NIP Data
Sheet.
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5.8.1 Basic configuration: “Sensor — Parameters” tab

~

r
Configuration ‘ = 23 |

Sensor - Parameter ‘ Sensor - Expert Software - Communication ] Software - Display | Software - Streaming |

Mode: _ - Interpolation rate ABZ Channel 1024

[C] ABZ output active Interpolation rate ABZ Channel . IRDIV2 = IRDI\
|| Simple SPI active Digital hysteresis: 1
Input signal amplitude: 660mVpp  +
Analog low pass: 150kHz v activate: | Channel V| Channel
Interpolation rate: 8000 Reference-point widtt 1 Increment
Nonius gradua 125
Read Verify Program
(EEPROM) (EEPROM) (EEPROM)

Close

.

Fig. 7: “Sensor - Parameters” configuration

The first tab of the “Sensor — Parameters” configuration can be used to make general settings, such as in-
terpolation rate and nonius graduation and the parameters for the input signals. Thus, the basic functions of
the GC-NIP can be switched without great effort.

Configuring the operating mode:

Nonius: The absolute position is calculated as the nonius value from the input signals of both channels.
The absolute position is stored in the POSI T register (= value displayed in the “Nonius measure-
ment” window). The CNT1 and CNT2 registers comprise the interpolation counters for the appropri-
ate channel (= count value in the windows “IP measurement, channel 1” or “IP measurement,
channel 2”). To ensure proper operation, the nonius graduation must be configured. It is also pos-
sible to store coefficients for correction of the nonius value in the EEPROM by way of a soft-
ware-based calibration process. For more information regarding the calibration process, see Sec-
tion 5.10.

Interpolator (2-channel): For use of the IC with one single or two independent sensors. The registers CNT1
or CNT2 comprise the interpolation counters for the appropriate channel. In this mode, it is not ne-
cessary to configure the nonius graduation.

Sensor adjustment 1, 2 and Z: Auxiliary signals are issued at the A, B and Z pins allowing analog adjustment
of the sensor signals. For further information, refer to the GC-NIP Data Sheet.

@ Note: The display in the “Nonius measurement” window corresponds to the content of the POSIT re-
gister and is specified by way of CFGBI SS/ STSEL( 1: 0) independent of the set operating mode. For further
information on the operating modes of the IC, refer to the GC-NIP Data Sheet.
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The settings selected for the EEPROM of the GC-NIP are saved by clicking on the “Programming” button.

The “Verify” button can be used for comparison of the data between the software and the EEPROM and de-

livers the result of the comparison at the end. If any differences are detected, it is possible to read out the

EEPROM values by clicking on the “Read” button and to accept them to the display of the software.

5.8.2 Extended configuration: “Sensor — Expert” tab

The “Sensor - Expert” tab is designed for further configuration of the GC-NIP. It is based directly on the
definitions of the configuration registers CFGL- 3, CFGBI SS, PREST1, PREST2 and NONOFFS which can be

programmed by these registers separately. For detailed descriptions and explanations of the individual para-

meters, refer to the Data Sheet. Reading, programming and verification of the parameters can be performed

similarly to the approach for the “Sensor — Parameters” tab.

L

Fig. 12: “Sensor - Expert” PRESET

P — = Confwion =N
Sensor - Parameter Sensor - Expert | Software - Communication \ Software - Display | Software - Streaming Sensor - Parameter Sensor - Expert | Software - Communication \ Software - Display | Software - Streaming
[Ceei] [ cre2 ) [ cres | [croarss | [(preseT | [Corer | (E&EGET) [ cre3 | ((cromiss ) [(preser |
GAIN CFGAF MODE TP TRGSLP  IRMAP IRD2SEL  IRDIV T DISMON DISVO PH2 PREENA PHBER PH1 ASYNC SYNC ZMODE 24 Y| soen
660mvpp |~ 1S0kMz | - | 0001 1|~ FAL |- 1 - M O of O 0O o] O 0| Incement - 1PULSE -
Phase correction value 2=0,000°  Phase correction value 1=0,000°
ENON EOFF EGAIN EABZ EFAST  EADC  EVIOW  TRI HD o[0T
ACTIVE |~ ACTIVE ~ ACTIVE ~ ACTIVE ~ ACTIVE ~ ACTIVE - AcThve ~ [ [
EEPROM s validated, | Invalidate EEPROM s validated, | Invalidate
Read Verify Program Read Verify Program
(EEPROM) (EEPROM) (EEPROM) (EEPROM) (EEPROM) (EEPROM)
Close Close
L L
H . k6 tH H . G ”
Fig. 8: “Sensor - Expert” CFG1 Fig. 9: “Sensor - Expert” CFG2
Confwion [ Confwion =N
Sensor - Parameter Sensor - Expert | Software - Communication \ Software - Display | Software - Streaming Sensor - Parameter Sensor - Expert | Software - Communication \ Software - Display | Software - Streaming
[Ccre1 | [ cre2 | [Graa] ((croarss | (PreseT | [crer | [ cre2 ) [ crea | [CRGBISS] [ PreseT |
NOSEL IRDIV2 DISGiz  MFED MR ZE2 DE Oz DI Ty ST SS0 RING SSITO STSEL GRAY STBIT READ32  BISSTO RE
] 1 v 00 L V| L [ [ L BISS - ] 517 | NONIUS - 30 9
DH OFFSCTL GAINCTL DISCTL
1 v sow + sow - (]
EEPROM s validated, | Invalidate EEPROM s validated, | Invalidate
Read Verify Program Read Verify Program
(EEPROM) (EEPROM) (EEPROM) (EEPROM) (EEPROM) (EEPROM)
Close Close
L L
H » kE L] H . k6 tH
Fig. 10: “Sensor - Expert” CFG3 Fig. 11: “Sensor - Expert” CFGBISS
Configuration [
Sensor - Parameter Sensor - Expert | Software - Communication \ Software - Display | Software - Streaming
[Cerer | [(cre2 ] [ crea | [(creaiss
decmal hexadecmal decmal hexadecmal
[} ox 0 0 ox 0
decimal hexadecmal
0 ox 0
EEPROM s validated, | Invalidate
Read Verify Program
(EEPROM) (EEPROM) (EEPROM)
Close
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5.8.3 Configuring the interface: “ Software — Communication” interface

This tab is used to make the settings for communication via the interfaces. For communication via the SPI

or BiSS interface, in addition to the clock setting for the interface, it is also possible to enter the hardware

address for the addressing of several slaves.

For the SPI interface, it is also possible to spe-
cify the waiting time after read access (for fur-
ther information, refer to the GC-NIP Data
Sheet).

In the area for the BiSS interface, the XML con-
figuration file (idbiss4743.xml) must be specified
to enable the software to identify the IC. It can
also be selected here whether only the position
data (single-cycle data) or all measurement data
registers are to be read out during a measure-
ment.

5.8.4 *Software — Display” configuration

Configuration

(o] [

Clock Divisor:

Hardware address:

Wait after RDO:

Clock Divisor:
Hardware address:
Config. fie:

Measurem:

{Automatic}

L] Multi Slave

9500 |us

L:\Messtechnik\Foerd... idbiss4743.xml ...

* ! Single-Cycle data only

Sensor - Parameter | Sensor - Expert | Software - Communication | Software - Display | Software - Streaming

1

1
0

3| = 15,00 MHz

s =500MHz

all measure data regist

Close

Fig. 13: Software - Communication

Configuration

(o] [

Unit: ihk Unit: Ink

Conversion: 1,000000 Conversion: 1,000000

Resolution: 1,0 Resolution: 1,0

Display all warnings and messages again

Sensor - Parameter | Sensor - Expert | Software - Communication | Software - Display | Software - Streaming

Ink
1,000000

1,0

Measuring unit and scaling for representation of
the measured value in the software (IP measure-
ments 1 and 2, display of the count value; nonius
measurement) can be changed in the “Display”
area. Furthermore, any warning and information
dialogs which were possibly been hidden by the

Close

operator can be reactivated here.

Fig. 14: Software display

5.8.5 Configuring the data recording: “ Software - Streaming” tab

The “Streaming” item can be used to record
parameters of the GC-NIP, such as corrected or
uncorrected ADC values, PHI and BQ continu-
ously. The data can then be exported as meas-
ured data or raw data as a CSV or metlab data
using the “Export” function (Options -> Export;
icon “White paper?? with arrow”).

Thus, it is possible to evaluate, edit and docu-
ment the data later. The recorded data can be
visualized simultaneously in the oscilloscope
view.

Configuration

(=<

Sensor - Parameter | Sensor - Expert | Software - Communication | Software - Display = Software - Streaming

Target directory:  C:\

Max. size: 500000 Samples (= 38,15 MByte)

Fill level: 0 Samples (= 0,00 MByte)
Reset stream

Import streaming file...

Fig. 15: “Software - Streaming”
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5.9 Oscilloscope

Furthermore, the software can be used to display the ADC values and parameters of the GC-NIP, for ex-
ample, graphically. Generally, it is possible to switch between the time-based mode and the XY representa-

tion.

o | B |3

% Oscilloscope

Graph: ® Time | | X)¥
Time base: 120 Samples/Div
Display: 7] Legend
Performance
Antialiasing
Activate Reset

Data track 1 “»r

Show Measure.: IP Chan... ~
Value: Sine corr. AD
Minimum: -1000 | [ Auto
Maximum: | 1000 5| =t
Reset track position
Mode: @ Lines Points
Colors: -
100,0fps @00
Fig. 16: Time-based oscillogram
% Oscilloscope B
W 2; Sinus korr
Graph: Time (o) XY}

Memory depth: 1200 Samples

Display: 7] Legend
Performance
Antialiasing
Activate Reset

Data track 1 4

] show Measure.: IP Chan... ~
ValueX:  Sine ADC

Minimum X:

Maximum X: 4

Value Y: Cosine ADC

Minimum Y: -495

Maximum Y:

Mode: Lines @ Points
Colors: N -

Fig. 17: xy representation
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5.9.1 View

The “View” panel can be used to select whether a representation is to be displayed as a function of the time
or in the XY system (Lissajous). The time basis or memory extent can be used to configure the number of
samples represented. In addition, further display elements can be activated/deactivated by way of switches.

5.9.2 Accumulation

If “Accumulation” is activated, a permanent overlay of several points of each displayed wave form is ob-
tained until the “Activate” switch is canceled and the “Reset” button is actuated.

5.9.3 Datatracks

The oscilloscope view provides up to 16 data tracks which can be assigned freely (channels). The display
can be turned on / off separately for each channel, as can the range of values for the display (also by way of
a button as an “Auto set” function), the mode of representation and the color. The list boxes “Measurement”
and “Value” can be used to specify the data value for the display.

5.10 Calibration process

The calibration process serves to determine the correction coefficients for a measuring system by way of a
nonius period such that errors in the determined absolute position can be detected and corrected. Upon
completion of the calibration process, the coefficients are stored in the EEPROM of the IC, and the correc-
tion is active for the subsequent measurements.

In addition to determination of the correction coefficients, the controller start values can be determined dur-
ing the calibration process and to adjust the phase shift of the input signals.

r ™y
Nonius calibration I&J

Configuration
Interpolation rate: oo

Nonius graduation: 125

Determine controller values

Activate phase adjustment

/| Calibration mode Reset coeffidents

Status

Execute Close

A

Fig. 18: Calibration process
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Table 26: Configuring the calibration process

Value

Interpolation rate

Nonius graduation

Determine controller values

Activate phase adjustment

Calibration mode

Interpolation rate to be used for calculation.
The relevant value is accepted from the configuration window. The configuration is written to the
IC when the calibration process is started.

Nonius graduation of the measuring system master track; corresponds to the number of sinus-
oidal periods within a complete nonius period. The master track corresponds to the track with
the higher number at sinusoidal periods (mechanically lower pole width) and is to be connected
to the input of channel 1.

Activates the determination of the controller starting values for reduction of the settling time
after power-on.

After settling of the controllers, a minimum number of samples is recorded and the controller
average values determined for at least one nonius period. For calculation, a continuous move-
ment of the measuring system over a complete nonius period is required. The values determ-
ined are stored in the EEPROM of the IC.

Determines the optimum settings for the phase correction of the GC-NIP in both channels.

For calculation, a continuous movement of the measuring system over a complete nonius peri-

od is required. The phase correction values determined are stored in the EEPROM of the IC at

the end of calculation. It is recommended to check the configuration after the phase adjustment
by way of a measurement (e.g. in the oscilloscope view, xy representation).

Activates the determination of the correction coefficient. For calculation, a continuous move-
ment of the measuring system over one complete nonius period is required. The coefficients
determined are written to EEPROM of the IC after calculation, and the correction is activated.

After starting the calibration process by clicking on the “Execute” button, the progress is displayed by way of

a progress bar. The text window displays further information regarding the current status, any error states

and the quality of the calibration process.

If the calibration process was completed without errors, the determined correction coefficients are stored in

the EEPROM and are used in subsequent measurements for error correction.

The “Reset coefficients” button can be used to delete correction values saved in the IC, thus deactivating

the correction. To accept the deactivation, the IC must be reset.

@ Note: In case of any modifications to the mechanical design of the measuring system, the dimensions,

the electrical input signals or

in case of changes in the circuit configuration, the correction coefficients must

be redetermined by way of a calibration process.
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6 Quick Start

Quick-start initial configuration:
— Power supply of the demo board via USB
— Sensor with 5 V supply voltage
— Sensor with differential output signals
— The starting configuration is read from the EEPROM as the default configuration.

— Further configuration and measured-value acquisition are performed via USB and using the PC pro-
gram.

Board configuration:

Jumper J1 open — SSI / BISS interface inactive

Jumper J2 closed — USB interface active (LD2 lights)

Jumper J3 open — SPI interface inactive

Jumper J4 open — The gain of the GC-LS for channel 2 is 0.66, as the 5V sensor is connected.
Jumper J5 open — The gain of the GC-LS for channel 1 is 0.66, as the 5V sensor is connected.
Jumper X7 (NRES) open — IC is not in the reset state.

Jumper X8 and X17 (SVCC1 and SVCC2) each on 1 —2 — sensor supply =5V

Sensor_SINP SINP
Sensor_SINN SINN
Sensor_COSP COSP H1
Sensor_COSN COSN
Sensor_REFP REFP
Sensor_REFN REFN
Sensor_SINP SINP
Sensor_SINN SINN
Sensor_COSP COSP
Sensor_COSN COSN CH2

Sensor_REFP REFP
Sensor_REFN REFN

)

GP-NIP

@)

Fig. 19: Differential input signals
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[ Start-up

The GP-NIP demo board is prepared such that it is ready for operation after connecting the supply voltage
and once the GC-NIP has been initialized with the default settings from the internal EEPROM or by way of
the configuration pins. For a detailed description of the configuration from the EEPROM, refer to the Data
Sheet.

7.1 Power supply

The test board is powered by connecting a 5V DC voltage to X13 or X15. If the USB interface at X14 is
used, the power can also be supplied directly via USB.

7.2 Selecting the interface

The demo board possesses the following serial interfaces: USB, SPI or BiSS which are selected by way of
the jumpers J1, J2 and J3 (see Table 19).

7.3 Signal supply

The sinusoidal, cosine and reference channels are connected directly to the GC-NIP via the 15-pin SUB-D-
female socket connectors X16 (Table 14) for channell and via X6 (Table 7) for channel 2 or via the push-on
terminal strip connectors X12 (Table 12) for channel 1 and X18 (Table 16) for channel 2.

Sensors with a supply voltage of 5V or 3.5V can be connected to the demo board directly. Both single-ended
and differential sensor signals can be processed. The illustrations below show examples of connecting dif-
ferent sensor types as examples.

Sensor with single-ended
output signals (2)

Sensor with single-ended
output signals (1)

Sensor with differential
output signals

Sensor_SINP SINP1/2 Sensor_SINP{ >———{SINP1/2 Sensor_SINP < >———SINP1/2
Sensor_SINN 8: SINNT/2 = —{SiNn1/2 —|Sinn1/2
Sensor_COSP COSP1/2 Sensor_COSP COSP1/2 Sensor_COSP COSP1/2
Sensor_COSN COSNI2 | 1Gosniz o [1cosniz o
Sensor_REFP REFP1/2 = Sensor_REFP REFP1/2 2Z Sensor_REFP REFP12 =
Sensor_REFN gi REFN1/2 & Sensor_VM REFNY2 (1 VO REFNT2 %
(®]
O © o
VOCH1/2 VOCH1/2 | vocH1/2
toonL ———— jondL toonL L———

AVSS AVSS AVSS

® The amplitude of the sensor and the [ ]
nominal amplitude of the GC-NIP are
matched to each other by way of the
configuration bits GAI N( 1: 0.

® The reference level VO is formed intern- =
ally.

The amplitude of the sensor and the u
nominal amplitude of the GC-NIP are
matched to each other by way of the
configuration bits GAI N( 1: 0) .

The reference level VO is provided by them
Sensor.

The amplitude of the sensor and the
nominal amplitude of the GC-NIP are
matched to each other by way of the
configuration bits GAI N( 1: 0) .

The reference level VO is formed intern-
ally and connected to the sensor.

For further notes and application examples, see the GC-NIP Data Sheet.
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7.4 Connecting the sensor
7.4.1 Supply voltage

Before the sensor is connected to the GP-NIP demo board, the supply voltage for the sensor must be set by
way of the jumpers X8 (channel , Table 9) and X17 (channel 2, Table 15). 5V and 3.3V types are differenti-
ated:

5V DC voltage Pin 1 — pin 2 5V DC supply voltage to the sensor
3.3V DC voltage Pin 2 — pin 3 3.3V DC supply voltage to the sensor

Table 27: Connecting the sensor

7.4.2 Configuring the nominal amplitude / setting the gain

To adapt the analog input stage to the amplitude of the input signals, it is imperative to set the gain of the
GC-NIP. Normally, 5V systems operate at a higher signal amplitude compared to 3.3V systems. Adaptation
of the amplitudes to the input stage of the GC-NIP is provided by way of the level-shifter circuit GC-LS on
the demo board. To this end, it is possible to switch the gain of the GC-LS between 1 and 0.66 by way of
jumper J5 (channel 1) and jumper J4 (channel 2). The configuration of the GC-LS and setting of the gain for
the GC-NIP are shown for different input signals in the table below.

Input voltage, Sensor voltage GC-LS Gain settings
nominal Uomom (MVpp) | (typical) .
Jumper J4 GAIN1 GAINO
\Y, 0.66 OFF

1 5 0 0
660 3.3V 1 ON 0 0
330 5V 0.66 OFF 0 1
250 3.3V 1 ON 0 1
180 5V 0.66 OFF 1 0
120 3.3V 1 ON 1 0
80 5V 0.66 OFF 1 1
60 3.3V 1 ON 1 1

Table 28: Configurations for different input amplitudes

7.5 Configuring the IC

Generally, the configuration of the GC-NIP IC can be differentiated by initialization from the internal
EEPROM and the default or pin configuration. The source for configuration is selected by way of a validity
identifier in the EEPROM. The EEPROM is marked valid if the identifier 0Ox134A is present at the EEPROM
address 0x00. Otherwise, the default settings or the pin configuration are used for initialization when the IC
is reset. A detailed description of configuration using the internal EEPROM can be found in the GC-NIP Data
Sheet.

The following settings are available for configuration by way of pins:
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Nominal amplitude S2
Analog low-pass filter S3
Nonius counting direction S4

Table 29: Pin configuration settings

The counting direction when calculating the absolute position can always be specified by way of the CFGDI R
pin, independently of the validity of the EEPROM.

CFGGAIN1 CFGGAINO Function
(switch position) (switch position)

0 (OFF) 0 (OFF) Nominal amplitude 660mV,,
0 (OFF) 1 (ON) Nominal amplitude 250mV,,
1 (ON) 0 (OFF) Nominal amplitude 120mV,,
1 (ON) 1 (ON) Nominal amplitude 60mV,

Table 30: Nominal amplitude configuration

CFGAF1 CFGAFO0 Function
(switch position) (switch position)

0 (OFF) 0 (OFF) Analog low-pass filter 150kHz (-0.5dB)
0 (OFF) 1 (ON) Analog low-pass filter 75kHz (-1dB)

1 (ON) 0 (OFF) Analog low-pass filter 10kHz (-1dB)

1 (ON) 1 (ON) Analog low-pass filter inactive

Table 31: Analog low-pass filter configuration

CFGDIR Function
(switch position)

0 (OFF) Counting direction forward (as the incremental counter, channel 1)

1 (ON) Counting direction reverse

Table 32: Nonius counting direction configuration
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8 Troubleshooting

Error:

The USB device was not detected. The message “No device detected” is displayed in the status bar of the
software.

Solution:

Check that the demo board is connected correctly. If so, the ON LED (LD5, green) and the interface
LED (LD1, LD2 or LD3, yellow) must light.

Were the device drivers installed correctly? Check that the demo board is specified in the Windows
device manager as “GEMAC — TB GC-NIP A” or “GEMAC — TB GC-NIP B” (additional version in-
formation may be appended to the string). If not, reinstall the software.

Is the correct interface selected? When using the USB interface on the demo board or the USB SPI
adapter, select the SPI interface in the toolbar of the software. Similarly, when using the USB-BiSS
adapter, select the BiSS interface.

Error:
The USB device was detected, but “Unknown” is displayed for the IC type.
Solution:

Was the correct interface selected on the demo board? Use the jumpers J1, J2 or J3 for selection
of the interface.

Is the device address on the demo board the same as set in the software? When using the demo
board, only one IC is operated at the SPI bus in most cases. In this case, the “Multi slave” option in
the “Configuration” window, “Software — Communication” area is activated. If several GC-NIP ICs
are to be used at one SPI bus, the hardware address must be the same as set in the software. If
configuration by way of pins is used (in case of invalid EEPROM), the hardware address "00" is val-
id, and only one IC can be operated at the SPI bus.

Is the clock frequency for the interface you are using too high? Select the clock frequency for the
SPI or BiSS communication using the list boxes "Clock Divisor:" in the area "Software - Communic-
ation" in the configuration window. If the IC was not detected, it is recommended to select a lower
clock frequency. For the SPI interface, the timing can be additionally adapted by increasing the
"Wait after RDO" value.

Is the configuration file for the BISS interface specified? To identify the IC via the BiSS interface, a
BiSS xml file is used. The path to this file is selected in the area "Software - Communication" of the
configuration window under "Config. file:". For GEMAC ICs, the file "idbiss4743.xml|" is used which
is stored in the program directory by default when the software is installed.
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